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Welcome to MAGic 
MAGic is a software solution ideally suited for computer users with low 
vision, or anyone who spends extended period s of time in front of a 
computer screen.  

MAGic lets you magnify your computer screen from 1 to 3 6 times its 
usual size. You can choose from a number of different adjustable views 
that let you see both a magnified and unmagnified portion of the screen 
at t he same time.  

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic 
moves the magnified area of the screen so you always see the text 
being read and highlights words as  they are spoken.  

Mouse and cursor enhancements help you track the location of the 
mouse pointer and cursor on the screen. You can choose from a wide 
variety of enhancement styles. MAGic lets you change the color of these 
enhancements, apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. 
You can create rules that replace one color with another or switch two 
colors. You can also apply color tinting, make your screen black -and-
white (m onochrome), and invert the brightness and colors of your 
display.  

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a 
way to quickly find and move to different area s of the screen. The MAGic 
multi -directional panning system gives you complete control with 
adjustable speed, direction, stop and start, and screen navigation 
controls.  
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System Requirements  
The recommended system requirements fo r MAGic are listed below.  

Specification  Minimum Requirement  

MAGic Standard Windows XP Home, Windows Vista Home 
Premium, Windows Vista Home Basic  

MAGic Professional and 
MAGic Pro Scripting 
Edition*  

Windows Vista Ultimate, Windows Vista  
Enterprise, Windo ws Vista Business, 
Windows Vista Home Premium, Windows 
Vista Home Basic, Windows XP, Windows 
Media Center Edition, Windows 2000, 
Windows XP Home and Pro 

Processor speed 450 MHz or higher  

RAM 256 MB (512 MB recommended)  

Required hard disk space  MAGic requires less than 200 MB of hard 
disk space for program and settings files. 
Additional space is required for the 
operating system, other programs, and 
the Windows swap file.  

Video* 256 color graphics  

* While MAGic will work with 256 colors, it 
is recommend ed that you use high or true 
color depth (16 -bit color or higher).  

Sound Windows compatible sound card (for 
speech option)  
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Installing MAGic  
1.  Insert the MAGic CD into your CD-ROM drive. 

2.  When the MAGic Setup dialog box appears, choose the MAGic 
Setup but ton.  

Tip:  If your MAGic installation CD does not start automatically, 
click the Start  button, select Run, and type D:\setup . If your 
CD-ROM is not D, substitute the correct drive letter.  

3.  The MAGic Setup program starts. You will hear the installation 
speak the instructions as they appear on your screen. Follow these 
instructions to complete the MAGic installation.  

Choose to run the automatic (typical) or guided (custom) installation of 
MAGic. The typical install ation, which is recommended for most users, 
installs the most common program features. Use the custom 
installation if you want to specify the default location where MAGic is 
stored on your hard disk, or if you want to install client or server 
components fo r remote access. This type of installation is recommended 
for advanced users.    

Starting MAGic  
MAGic gives you a variety of ways to start the program.  

 Press the hot key, ALT+CTRL+M, which can be automatically a ssigned 
from the  MAGic Startup Wizard .  

 Double-click the MAGic icon on your desktop.  

 From the Start  menu, choose Programs, open the MAGic submenu, 
and choose MAGic. 

 From the Start  menu, choose Run, type magicxx , where xx is the 
version number, and press ENTER.  

After you start MAGic for the first time, you can  do the following:  

 Designate a hot key assignment to launch MAGic.  

 Choose to run the program when Windows starts.   
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 Choose if you want MAGic to play sounds instead of hearing spoken 
descriptions of Wi ndows controls.  

 Install audio training material.  

Quitting MAGic  
To quit MAGic, do one of the following:  

 Press ALT+F4  

 Click the Close button   in the top right hand corner of the window.  

 Select Exit from the File  menu.  

Tip:  If you want MAGic to ask you to save your settings  when you 
quit, open the File menu and choose Preferences. Select the 
Prompt to Save Settings on Exit check box. 

Getting Starte d 
Start MAGic by pressing ALT+CTRL+M or by double -clicking the MAGic 
program icon on your Windows desktop. You can also start MAGic by 
opening the Start  menu, choosing Programs, MAGic and then selecting 
MAGic. 

Tip:  You can change how and when MAGic starts  by opening the  
File menu and choosing Preferences. 

When you first start MAGic, your screen is displayed in 2× magnification 
using the Full view. Speech will also be enabled. You can change the 
magnification level , magnified vie w, speech, and many other options by 
using the MAGic user interface . 

The user interface  is a small window that appears in approximately the 
center of your display. This window allows you to control all aspects of 
MAGic and contains the magnification and speech buttons  in addition to 
the MAGic menu and title bar s. The user interface is shown below.  
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Magnification and Speech Buttons  
One of the first things you will notice about the user interface  is the 
rows of blue and orange buttons. The blue buttons control magnification 
features while the orange buttons control speech. Below are brief 
descriptions of each button.  

Button  Function 
 

  

Use the Magnification  button to enable or disable 
magnification.  

  

The current magnification level  can be adjusted with 
the two Magnification Level  buttons. The number in 
the b etween the two buttons shows the current level.  

 
Use the Mouse Enhancements button to 
enable/disable enhancements and modifications for 
your mouse pointer. These enhancements make the 
mouse pointer easier to track and maneuver on your 
screen. 
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Button  Function 
 

  
Use the Cursor Enhancements button to 
enable/disable enhancements for your cursor. These 
enhancements make the cursor easier to follow when 
editing or writing text.  

 
Use the Colors Enhancements button to enable/disable 
color enhancements. This feature allows you to 
replace colors, adjust the brightness and contrast, 
apply tinting, blend colors, and invert the brightness 
and colors of your display.  

  
Use the Locator button to enable/disable the Locator 
function. The Locator fun ction allows you to find items 
on your screen.  

 
Use the Focus Enhancements button to enable/disable 
the Focus Enhancements function. This function places 
a rectangular border around the item that is currently 
selected on your monitor.  

  
The Resize View button allows you to change the 
dimensions of your magnified view.  

 
Select your preferred magnified view from the 
Magnified Views  list.  

  
Use the Speech button to enable or disable speech.  

  
Use the Mouse Echo button  to toggle the mouse echo 
feature on and off. The mouse echo feature enables 
MAGic to read text that you point at with the mouse.  

  
Use the Typing Echo button  to enable or disable the 
typing echo. If typing echo is enabled, MAGic 
announces the words or characters you type.  
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MAGic Menus 
Located above these buttons is the menu bar . The menu bar allows you 
to customize speech, magnification, and your keyboard. You can also 
view help information and perform other functions. Each menu is 
described below.  

 

Menu Purpose 

File  The File menu allows you to save your setting s, 
restore the original Freedom Scientific  settings, and 
change your MAGic preferences.  

Magnification  The Magnification  menu allows you to customize 
how you view your screen with MAGic. You can also 
change mouse options, panning  settings, view 
properties and more.  

Speech You can customize MAGic©s speech components to 
fit your particular needs. The Speech menu allows 
you to customize how you hear MAGic.  

Tools The Tools menu allows you to customize how you 
use your computer's keyboard with MAGic. You can 
also access the Freedom Scientific Script Manager 
application from this menu. (Note: Requires MAGic 
Pro Scripting Edition.)  

Help The Help menu provides you with detai led help 
information for the various MAGic functions and 
options. You can also view information on the 
newest features for this release and see your 
current MAGic version.  
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The MAGic Key 
The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the 
MAGic Key in combination with other keys activates a number of MAGic 
commands. If you want to assign the MAGic Key to a different key on 
your keyboard, open the Tools menu, choose Keyboard Manager, and 
then choose MAGic Key.  

Reading Text with MAGic  
MAGic can use synthesized speech to read text that appears on your 
screen, including documents, menus, dialog boxes, e -mail messages, 
Web pages, and more. Additionally, MAGic can highlight the text as it is 
spoken. To customize MAGic©s speech, use the commands available on 
the Speech menu. 

Tip:  You can silence MAGic©s speech at any time by pressing CTRL. 
To toggle speech on or off, press MAGic Key+F3. 

Using the Mouse to Read Text  
Mouse echo is a feature that allows you to read te xt with your mouse. 
To use mouse echo, just move your mouse pointer to some text on your 
screen and then stop. After a short delay, MAGic will speak the word you 
pointed to. You can use the Mouse Echo button to enable or disable this 
feature.  

In addition,  you can hold down the MAGic Key and press the left mouse 
button to start reading from the current location of the mouse pointer. 
You do not need to hold down the MAGic Key while MAGic reads. MAGic 
stops reading when you move the mouse or press a key.  

Using the Keyboard to Read Text  
MAGic has a number of different keystrokes that let you use the 
keyboard to read text. To use these keystrokes, move the insertion point 
or mouse pointer to any location within the document. Then  press one 
of the following key combinations to read from that location:  

 To begin reading from your current location, press MAGic 
Key+SPACEBAR or INSERT+DOWN ARROW.  
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 To read the current character, press NUM PAD 5. 

 To read the current word, press MAGic Key+ALT or INSERT+NUM PAD 
5. To spell the current word, press  the keystroke twice quickly.  

 To read the next word, press INSERT+RIGHT ARROW. To read the 
previous word, press INSERT+LEFT ARROW. 

 To read the current line, press MAGic Key+L or INSERT+UP ARROW. 
To read the next line, press DOWN ARROW. To read the previous line, 
press UP ARROW. 

 To read from the beginning of the line to the current position of the 
cursor, press INSERT+HOME. To read from the current position of the 
cursor to the end of the line, press INSERT+PAGE UP. 

 To read the current sentence, press MAGic Key+S. To read the next 
sentence, press CTRL+MAGic Key+S. 

 To read the current paragraph, press MAGic Key+P. To read the next 
paragraph, press CTRL+MAGic Key+P. To read the previous 
paragraph, press ALT+MAGic Key+P. 

 To begin reading a column of text from your current location, press 
MAGic Key+C. 

 To read text that you have selected, press MAGic Key+CTRL or 
INSERT+SHIFT+DOWN ARROW.  

 To hear the contents of the Clipboard, press MAGic Key+X. 

Note:  By default, the MAGic Key is assigned to the CAPS LOCK key. 
To change this, open the Tools menu, choose Keyboard 
Manager, and then  choose the MAGic Key button .  

When you read text with these keystrokes, MAGic highlights the word it 
is currently speaking. To change the color and/or style of this 
highlighting, open the Speech menu and choose Highlight Options .  

Reading Text in Dialog Boxes  

In addition to the reading commands listed previously, you can use the 
following keystrokes to hear informatio n in Windows dialog boxes:  

 To read the title bar of the active window or dialog box, press MAGic 
Key+T or INSERT+T. 
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 To read the bottom of the active window (which usually contains the 
status bar), press INSERT+PAGE DOWN. To read the top line of the 
active window (which usually contains the title bar), press 
INSERT+END. 

 To hear the name of the default button that will be activated when 
you press ENTER, press INSERT+E. 

 To read the currently selected dialog box option (such as an edit box 
or check box), press MAGic Key+TAB or INSERT+TAB.  

 To hear the access key for the currently selected dialog box option, 
press SHIFT+NUM PAD 5. 

Getting Help  

Online Help System  
To access MAGic©s online help system, select Help Topics from the Help 
menu, which is lo cated on the menu bar of the MAGic application 
window. Use the Contents tab to navigate the help system. Use the 
Index  or the Search tabs to search for specific topics within the help 
system. If you want MAGic to read the help topics to you, position the 
mouse pointer toward the beginning of the help page, and press MAGic 
Key+SPACEBAR. You can move to the next topic by clicking the "Next" 
link at the bottom of the page. To return to the previous topic, click the 
"Back" link.  

What©s This? Help 
MAGic©s What©s This? help is context-sensitive help that you can use as 
a reference when working with MAGic©s user interface or dialog boxes. 
Press SHIFT+F1 on any button on the user interface, or co ntrol in a 
dialog box to see a brief description of the purpose of the control and 
how to use it.  

MAGic User©s Guide 

We provide you with the content of the MAGic online help system in the 
MAGic User©s Guide, which is printed in large text for easier readi ng. 
This book contains detailed descriptions of MAGic©s features, and also 
pull -out reference cards.  
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MAGic Basic Training 
Listen to the MAGic Basic Training to learn the fundamentals of using 
MAGic Screen Magnification. For more information, see Basic Training  
on page 11 . 

Technical Support  
If you do not find the answers to questions or problems that you have, 
contact Freedom Scientific Technical Support, (727) 803 -8600.  

About MAGic  
Select About MAGic from the Help menu on the MAGic user interface to 
view the version number of MAGic you are currently running.  

Basic Training 
The basic training for MAGic is included in DAISY format on your MAGic 
program CD. When you install MAGic, you are also asked if you want to 
install these materials. You can listen to and read the training modules 
by using the FSReader Demo DAISY reader included with MAGic. To start 
FSReader Demo, open the Start  menu, open the MAGic program group, 
and choose FSReader Demo. Alternatively, you can open the MAGic Help 
menu and choose Training . 

After you start FSReader Demo, a list of all DAISY books in the current 
folder appears. To begin the basic training, select the 
"MAGicBasicTraining" DAISY book and choose Open. For more 
information on using FSReader, select the "FSReaderGettingStarted" 
DAISY book and choose Open.  

These training modules are designed to give you a basic overview of 
MAGic. You will learn how to change your magnification and speech 
preferences, along wit h several other techniques. All users are 
encouraged to take advantage of this training.  



12  

MAGic Hot Keys 

General 

Start MAGic 

ALT+CTRL+M (default keystroke ­ 
can be changed using  the Startup 
Wizard) 

Run Script Manager* INSERT+0 

Minimize/Restore the MAGic  User 
Interface  

MAGic Key+U 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Open MAGic Context Menu MAGic Key+APPLICATION Key 

*Only available for MAGic Pro Scripting Edition  

Magnification, Views, & Enhancements  

Increase Magnification  
MAGic Key+NUM PAD PLUS or 
CTRL+EQUALS 

Decrease Magnification  
MAGic Key+NUM PAD MINUS or 
CTRL+DASH 

Magnification  Toggle On/Off  MAGic Key+DELETE 

Toggle between 1x Magnification   MAGic Key+SHIFT+DELETE 

Switch to Next Magnified View  MAGic Key+NUM PAD SLASH 

Switch to Previous Magnified View  SHIFT+MAGic Key+NUM PAD SLASH 

Toggle Color Enhancements On/Off  MAGic Key+F12 

Toggle Cursor Enhancements On/Off  MAGic Key+F8 

Toggle Mouse Enhancements On/Off  MAGic Key+F4 
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Panning and Screen Movement  
Pan Right MAGic Key+RIGHT ARROW 

Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during Panning  NUM PAD PLUS  

Decrease Speed during Panning NUM PAD MINUS 

Move to Left Edge of Screen in 
Magnified View  MAGic Key+HOME 

Move to Right Edge of Screen in 
Magnified View  MAGic Key+END 

Move to top of Screen  MAGic Key+PAGE UP 

Move to Bottom of Screen  MAGic Key+PAGE DOWN 

Move to Beginning of Next Line  MAGic Key+ENTER 

Tracking 
Tracking Toggle On/Off  MAGic Key+R 

Move View to Mouse Point er MAGic Key+NUM PAD 5 

Move View to Cursor SHIFT+MAGic Key+NUM PAD 5 

Tether Mouse to Display  CTRL+INSERT+NUM PAD MINUS 

Cursor Movement  
Route Cursor to Mouse INSERT+NUM PAD PLUS 

Route Mouse to Cursor INSERT+NUM PAD MINUS 
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Locator Mode 
Start Locator  MAGic Key+F10 

Stop Locator and Move to Selected 
Area 

ENTER 

Stop Locator without Moving the 
Magnified Area  

ESC 

Move Left  LEFT ARROW 

Move Right  RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to End of Line  END 

Move to Beginning of Line  HOME 

Move to Top of Screen PAGE UP 

Move to Bottom of Screen  PAGE DOWN 

Quick View Frame 
Toggle Quick View Frame On/Off   MAGic Key+Q 

Set upper left corner of fram e MAGic Key+LEFT BRACKET 

Set lower right corner of frame  MAGic Key+RIGHT BRACKET 

Create frame around current dialog 
box option  

MAGic Key+LEFT BRACKET twice 
quickly  

Open Quick View Manager MAGic Key+9 

Speech 
Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+F3 



15  

Voice Profiles  MAGic Key+F11 

Set Screen Echo INSERT+S 

Select Verbosity Scheme  ALT+INSERT+S 

Document and Text Reading  

Read All from Location  
MAGic Key+SPACEBAR or 
INSERT+DOWN ARROW 

Read Active Window (reads from the 
beginning of document window)   

MAGic Key+SPACEBAR (twice) or 
INSERT+DOWN ARROW (twice)  

Say All INSERT+DOWN ARROW 

Alternate Say All  ALT+INSERT+DOWN ARROW 

Say Currently Selected Text  
MAGic Key+CTRL or 
INSERT+SHIFT+DOWN ARROW 

Say Current Character NUM PAD 5 

Say Current Word 
MAGic Key+ALT or INSERT+NUM PAD 
5 

Spell Current Word  
MAGic Key+ALT (twice) or 
INSERT+NUM PAD 5 (twice)  

Next Word INSERT+RIGHT ARROW 

Prior Word INSERT+LEFT ARROW 

Select Next Word  INSERT+SHIFT+RIGHT ARROW 

Select Prior Word  INSERT+SHIFT+LEFT ARROW 

Say Current Line MAGic Key+L or INSERT+UP ARROW 

Next Line  DOWN ARROW 

Prior Line UP ARROW 

Read to Cursor INSERT+HOME 
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Read from Cursor INSERT+PAGE UP 

Say Current Sentence MAGic Key+S 

Next Sentence  CTRL+MAGic Key+S 

Say Current Paragraph MAGic Key+P 

Read Column from Current Position  MAGic Key+C 

Say Contents of Clipboard MAGic Key+X 

Note: When using the document and text reading comma nds, if you move 
the mouse MAGic reads from the current location of the mouse 
pointer. If you move the insertion point, MAGic reads from the 
location of the insertion point.  

Dialog Box Reading 
Say Title Bar MAGic Key+T or INSERT+T 

Read Bottom of Window  INSERT+PAGE DOWN 

Say Top Line of Window INSERT+END 

Say Default Button in Dialog Box  INSERT+E 

Say Window Prompt and Text  MAGic Key+TAB or INSERT+TAB 

Say Current Access Key SHIFT+NUM PAD 5 

Table Reading 
Say Current Cell ALT+CTRL+NUM PAD 5 

Cell to Right  ALT+CTRL+RIGHT ARROW 

Cell to Left  ALT+CTRL+LEFT ARROW 

Cell Below ALT+CTRL+DOWN ARROW 

Cell Above ALT+CTRL+UP ARROW 

First Cell  ALT+CTRL+HOME 
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Last Cell ALT+CTRL+END 

First Cell i n Column ALT+CTRL+SHIFT+UP ARROW 

Last Cell in Column ALT+CTRL+SHIFT+DOWN ARROW 

First Cell in Row ALT+CTRL+SHIFT+LEFT ARROW 

Last Cell in Row ALT+CTRL+SHIFT+RIGHT ARROW 

Typing Echo 
Cycle through I ndicate Capitalization 
options  MAGic Key+F2 

Cycle through Typing Echo Unit 
options  INSERT+2 

Mouse Echo 
Mouse Echo Toggle MAGic Key+M 

Note: Toggling the mouse echo rotates between speak lines, speak  words, 
and mouse echo off.  

Some actions in MAGic do not have hot keys assigned. You can define hot 
keys for these features from within the Keyboard Manager dialog box.  
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Windows Shortcut Keys  

General 
Get Help F1 

Open the Start  menu WINDOWS Key or CTRL+ESC 

Open Windows Explorer  WINDOWS Key+E 

Open the Run dialog box  WINDOWS Key+R 

Find file or folder from Desktop  F3 

Minimize all windows  WINDOWS Key+M 

Switch between programs  ALT+TAB 

Quit the active program  ALT+F4 

For Windows and Menus 
Open the application control menu  ALT+SPACEBAR 

Move to the menu bar  ALT 

Choose a menu command ENTER 

Move between menus  ALT, arrow keys 

Close a menu ESC 

Close a cascading menu ALT 

Open a child window control menu  ALT+HYPHEN 

Close a child window  CTRL+F4 

Open the context menu  APPLICATION Key or SHIFT+F10 
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For Dialog Boxes 
Move through dialog box options  TAB 

Move backward through dialog box 
options  SHIFT+TAB 

Move to another tab  CTRL+TAB 

Reverse direction through tabs  CTRL+SHIFT+TAB 

Move to f irst option  HOME 

Move to last option  END 

Select or clear an item in a list  SPACEBAR or CTRL+SPACEBAR 

Select or clear a check box  SPACEBAR 

For Reading Text 
Move left one character  LEFT ARROW 

Move right one character  RIGHT ARROW 

Move left one word  CTRL+LEFT ARROW 

Move right one word  CTRL+RIGHT ARROW 

Move to beginning of line  HOME 

Move to end of line  END 

Move up one paragraph  CTRL+UP ARROW 

Move down one paragraph  CTRL+DOWN ARROW 

Scroll up one screen  PAGE UP 

Scroll down one screen  PAGE DOWN 

Move to beginning of document  CTRL+HOME 

Move to end of document  CTRL+END 
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For Editing Text  
Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete character to the left  BACKSPACE 

Delete character to the right  DELETE 

Select one character left  SHIFT+LEFT ARROW 

Select one character right  SHIFT+RIGHT ARROW 

Select one word left  CTRL+SHIFT+LEFT ARROW 

Select one word right  CTRL+SHIFT+RIGHT ARROW 

Select to beginning of line  SHIFT+HOME 

Select to end of line  SHIFT+END 

Select to beginning of document  CTRL+SHIFT+HOME 

Select to end of document  CTRL+SHIFT+END 

Select all  CTRL+A 

For Windows Explorer 
Rename selected file or folder  F2 

Open properties  ALT+ENTER 

Refresh a window F5 

Switch between panes  F6 or TAB 

Go up a level BACKSPACE 

 


